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Corel Draw 
Lesson no. 1: Corel Draw Introduction 

COURSE CONTENTS COREL DRAW 

INTRODUCTION 

➢ What is the use of Corel Draw? 

➢ Support Application Formats 

ON SCREEN INTRODUCATION 

➢ Tool Bars 

➢ Tool Box 

➢ Property Bar 

➢ Status Bar 

WORKING WITH DOCUMENT 

➢ Creating New Documents 

➢ Working with tool box 

➢ Making Drawings 

➢ Practical Work. 

CREATING GRAPHICS 

➢ Working with Notes 

➢ Making Drawings 

➢ Cutting Object Apart 

➢ Artistic Media Tool 

➢ Practical work 10 Hrs.  

DOCUMENTS SETTINGS 

➢ Settings Page Size & Orientation 

➢ Settings Page Backgrounds 

➢ Add & Delete Pages 

➢ Making Drawing 

➢ Practical Work 5 Hrs. 
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Adobe Photoshop 
COREL DRAW FEATURES 

➢ Fill & Outlines 

➢ Using Colors 

➢ Using Eye Dropper & Paint Bucket 

➢ Practical Work 5 Hrs. 

 

MODIFIYING THE TEXT 

➢ Adding Text 

➢ Character & Paragraph Formatting 

➢ Creating Applying & Editing Graphics Text 

➢ Practical Work 4 Hrs. 

MORE ON COREL DRAW 

➢ Skewing & Stretching Objectives  

➢ Drop Shadows 

➢ Fitting Text to Path 

➢ Grouping & Combining Objects 

➢ Practical Work 4 Hrs. 
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1. INTRODUCTION COREL DRAW 

What is the use of Corel Draw? 

 
Introduction of Corel Draw:- CorelDraw (styled CorelDraw) is a vector graphics 
editor developed and marketed by Corel Corporation. It is also the name of Corel's Graphics Suite, which 

includes additionally the bitmap-image editor Corel Photo-Paint as well as other graphics-related programs. 

CorelDraw is designed to edit two-dimensional images such as logos and posters, Sign-Making, 
Manufacturing, Advertising and Industrial works with enjoyment. It is the perfect tool of graphic designing. 
The Uses of CorelDraw. Corel draw is vector-based designing software that is used for creating logos, 
flexes, brochures, invitation cards, business cards, flyers, posters, website layouts, amazing characters, 
cartoons, vectors and illustrations and any kind of vector designing based on the lining. 
 
 

History of Corel Draw 
 
In 1987, Corel engineers Michel Bouillon and Pat Berne undertook to develop a vector-based illustration 

program to bundle with their desktop publishing systems. That program, CorelDraw, was initially released in 

1989. CorelDraw 1.x and 2.x ran under Windows 2.x and 3.0. CorelDraw 3.0 came into its own with 

Microsoft's release of Windows 3.1. The inclusion of TrueType in Windows 3.1 transformed CorelDraw into 

a serious illustration program capable of using system-installed outline fonts without requiring third-party 

software such as Adobe Type Manager; paired with a photo-editing program (Corel Photo-Paint), a font 

manager and several other pieces of software, it was also part of the first all-in-one graphics suite. 

File format 

Support Application/Formats 

A file format defines how an application stores information in a file. If you want to use a file created in a 
different application than the one you are currently using, you must import that file. Conversely, if you 
create a file in one application and want to use it in another application, you must export the file to a 
different file format. When you name a file, an application automatically appends a filename extension, 
usually three characters in length (for example, .cur, .bmp, .tif, and .eps). This filename extension helps you 
and the computer differentiate between files of different formats. 
• GIF 

• JPEG (JPG) 

• JPEG 2000 (JP2) 

• Kodak Photo CD Image (PCD) Etc. 

Start Corel Draw 

Start 

 All Programs 

           CorelDraw Graphic Suite X6 

             CorelDraw X6 

 

https://en.wikipedia.org/wiki/Vector_graphics_editor
https://en.wikipedia.org/wiki/Vector_graphics_editor
https://en.wikipedia.org/wiki/Corel
https://en.wikipedia.org/wiki/Bitmap-image_editor
https://en.wikipedia.org/wiki/Corel_Photo-Paint
https://en.wikipedia.org/wiki/TrueType
https://en.wikipedia.org/wiki/Adobe_Type_Manager
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Adobe Photoshop 
              

Extension:-     .CDR (Corel Draw) 

 

1. ON SCREEN INTRODUCATION 

First Screen of Corel Draw: Whenever we open Corel Draw the Corel Draw first screen dashboard like 

below:-  

  

Title toolbar 
Menu toolbar 

Tool Box 

Standard toolbar Property Toolbar 

Status Toolbar 

Working 

Page 
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Locating tools in the toolbox 

The following illustration shows the other flyouts in the default CorelDRAW toolbox and can help you locate tools 

more easily. 
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Lesson no. 2: Corel Draw Toolbox 

Working with Toolbox:- 
  
The toolbox contains tools for drawing and editing images. Some of the tools are visible by default, 

while others are grouped in flyouts. Flyouts open to display a set of related CorelDraw tools. A 

small flyout arrow in the lower-right corner of a toolbox button indicates a flyout. You can access 

the tools in a flyout by clicking the flyout arrow. After you open a flyout, you can easily scan the 

contents of other flyouts by hovering over any of the toolbox buttons which have flyout arrows. 

Flyouts function like toolbars when you drag them away from the toolbox. This lets you view all the 

related tools while you work. 

 
 
 

              

 

 

 

 

 

 

 

Corel Draw Tool Box and its Functions 
 

1. Pick Tool - To select, resize, and rotate toward the image object. 

2. Shape Edit - 

a. Shape: Editing an image object shape. 
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a. Smudge Brush: Alter / distort the overall picture with attractive shorelines. 

b. Roughen Brush: Alter / distort the overall outline shape drawing by attractive 

shorelines. 

c. Free Transform Tools : Transform image objects using rotation (rotation)free, 

rotation  

d. Angle, and resize, and also tilt the image shape. 

3. Cutting tools 

 

 

 

The Cutting tools foldout menu gives access to four different tools: 

a. The Crop tool: Draws a rectangle through objects, everything outside the 

rectangle is then deleted. Works for simple objects, complex objects are converted to 

a bitmap, after which the bitmap is cropped. 

. 
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b. The Knife tool: The Knife tool useful tool, click on one side of an object, next click 

on the other side of the object, and the object will be cut into two by a straight line 

between the two points. Cutting along a curved line can be done by keeping the 

mouse button pressed while moving from side to side. It is important to watch the 

mouse cursor during operation, the tool only works you click when the cursor knife 

symbol points straight down. After cutting the two halves can be selected separately. 

 

 

 

 

 

c. The Eraser tool: similar to the knife tool, but cuts with a thick zone, and this tool 

only works when it is dragged. Another difference is that the resulting object, 

although consisting of two halves, still is a single object. To separate the two halves 

you need to break the object apart: arrange > Break apart (ctrl K) 

 

 

 

 

d. Virtual Segment Delete tool: deletes parts of an object behind crossed lines. 

It's best explained by the image below: 
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Lesson no. 3: Corel Draw Toolbox 

Corel Draw Tool Box and Function Working with Toolbox:- 
  
 

                Zoom tool (Z) - Change the magnification level of the document window 

 
 
 
 
 
 
 
 

             Hand tool (H) - Drag hidden areas of a drawing into view without changing the  

zoom level. 
 

 
  

 

              

 

Curve Tools 

 

 

 

 

 

 

 

 Freehand tool (F5) - Draw curves and straight line segments. 
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                2-Point Line tool - Draw a straight line by drawing from the starting point to the 

               Endpoint. 

 

 

          

 

 

 

 

 

 

  

 Bezier tool - Draw curves one segment at a time. 

 

 

 

 

 

 

 

                   Artistic Media tool (I) - Add artistic brush, spray, and calligraphic effects by using  

                 Freehand strokes.  
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                Pen tool - Draw curves in segments, and preview each segment as you draw. 

 

 

 

 

 

 

 

              

             B-Spline tool - Draw curved lines by setting control points that shape the curve  

                without breaking it into segments. 
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                   Polyline tool - Draw connected curves and straight lines in one continuous action 

 

. 

 

 

 

 

 

 

 

 

                     3-Point Curve tool - Draw a curve by dragging from the starting point to the  

 endpoint and then positioning the center point. 

 

 

 

 

 

 

 

 

 

                 3 Point Curve draws with Ctrl + Shift Key for Roundness 
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Lesson no. 4: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
  

SMART TOOLS FLYOUTS 

 

 

 

              Smart Fill tool - Create objects from overlapping areas, and apply a fill to those  

              objects. 

 
 
 
 
 
 
 
 
 
 
 

             Smart Drawing tool (Shift+S) - Convert freehand strokes to basic shapes or  

              smoothed curves. 

 

 
  

 

              

 

 

Rectangle tools 

 

 

 

 Rectangle  Flyouts 
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Rectangle tool (F6) -Draw squares and rectangles by dragging in the drawing 

window. 

 

 

 

 

 

 

 

                 3-Point Rectangle tool - Draw rectangles at an angle. 

 

 

 

 

 

 

 

Ellipse tools   

 

 

 

 

Ellipse Flyouts 
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                Ellipse tool (F7) - Draw circles and ellipses by dragging in the drawing window. 

 

 

          

 

 

 

 

  

 

 

                3-Point Ellipse tool- Draws ellipses at an angle.   
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Lesson no. 5: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
  

Object tools Flyout  

 

 

 

              Polygon tool (Y) - Polygon tool the polygon Tool draws 3 to 500 sided polygons.   

    Select the number of sides in the active property bar, and click and drag to draw the 

              polygon. After drawing the number of sides can still be changed.     
 
 
 
 
 
 
 
 
 
 
 
 
 
 

             Star tool - To draw a perfect star, click the Star tool,   and drag in the drawing window   

until the star is the size you want. After drawing the number of sides can still be 

changed. The Star Tool draws stars with 3 to 500 points. Select the number of points in 

               the active property bar, and click and drag to draw the star. After drawing the number of 

               points can be changed. 
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Complex Star tool- Draw stars that have intersecting sides. Complex Star 

Tool The Star tool draws stars with 3 to 500 points. A complex star differs from a star in 

the way the arms are connected, leaving a hole in the middle. Select the number of points 

in the active property bars, and click and drag to draw the star. After drawing the number 

of points can be changed. 

 

 

 

 

 

 

 

 

 

 

                 Graph Paper tool (D) -You can draw a grid and set the number of rows and            

 columns. A grid is a grouped set of rectangles that you can break apart. You can change   

the default settings of the Graph Paper tool to specify the number of rows and columns for  

new grids.  

 

 

 

 

 

 

 

 

 

 



 

www.dotnetinstitute.co.in           Call us at - 011-4004 0815 

Corel Draw 
 

 

                Spiral tool (A) - You can draw two types of spirals: symmetrical and logarithmic. 

                 Symmetrical spirals expand evenly so that the distance between each revolution is 

                 equal. Logarithmic spirals  expand with Increasingly   larger   distances   between  

                 revolutions. You can set the rate by which a l logarithmic  spiral  expands outward.  

                 Type a value in the Spiral revolutions box on the property bar. On the property bar,  

                 Click one of the following buttons: 

➢ Symmetrical spiral  

➢ Logarithmic spiral 
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Lesson no. 6: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
  

PERFECT BASIC SHAPES 

 

 

 

               Basic Shapes tool - The basic shapes, or perfect shapes, in Draw have 1 to 3 

              "glyphs" which are editable when the perfect shape tool or node edit tool are selected. 

              The glyphs can also be modified from the object properties docker. CorelDRAW currently 

              has your "Perspective", "Cross" and "Arrow" shape, all editable as you describe. 

 
 
 
 
 
 
 
 
 
 
 

 
             Arrow Shapes tool -Draw-  You  can find the  arrow  shapes by  selecting Common 

             Shapes from the toolbox (you can find it in the flyout on the Polygon tool). There is a drop 

             down in the Property Bar that has arrow shapes you can choose from. 
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Flowchart Shapes tool - Among the tools are the Flowchart Shapes. When you click 

this tool, the Property Bar will reveal the available shapes, when you click the 

Perfect Shapes button. Select one of the shapes, and drag your mouse to create the 

chosen shape. Create further shapes to finish the flowchart. Add text and shadows. 

 

 

 

 

 

 

 

                 Banner Shapes tool - Select Banner Shapes from the Toolbox and choose the  

                second banner from the drop-down menu in the Property Bar. Draw a banner. Note the 

                red and yellow nodes in the upper left of the Perfect Shape.  

                Using the Shape Tool, grab the yellow node and move it on the vertical axis. Reducing 

                or increasing the size of the banner's left tail also effects the center fold and right tail. 

                This time, grab the red node with the Shape Tool. Move the node on the horizontal axis  

                and note how either lengthening or shortening the center fold of the banner also affects 

                the tails.  

  

 

 

 

 

 

 

                Callout Shapes tool - You can use  different  shapes  for the  callout text  within a  

               drawing. Callout shape.   Under Callout Shapes, select the first design in the drop-down 

                   menu. Grab the red node and pull it down beneath the rectangle of the Perfect shape. Be 

               careful to make sure the node is in the center of the Callout Shape's tail.  

               As we did before, set the Outline to None and Fill to the Fountain Fill colors of your  

               choosing.       
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                Text tool (F8) - The text tool is used add text to illustrations. There are two kinds of 

               text in Coreldraw; artistic text and paragraph text. Artistic text is used for small amounts 

               of texts, usually just one or two lines; it works well for things like headings, text effects 

               and captions. The appearance and placement of artistic text can be thoroughly 

               manipulated, character per character if necessary. 
 
             
      Paragraph text is used for adding large amounts of text. Instead of editing the lines and 
               characters, you determine the shape of a container for the text to reside in. These 

               containers are normally rectangular, but can be any shape you want, it is also possible  

               to distribute a single block of text over many shapes. Although artistic text and paragraph 

               text have different purposes, they can be converted from one type into another. 

 

 Adding text to a drawing 

            Adding artistic text. To add artistic text to a drawing, select the text tool and click where 

            You want the text. A blinking cursor (|) will appear,  and  you  can  now  type  your  text,  

            when  you're finished, click somewhere else to  add  another t ext or click on the selection 

            tool to edit the text (or press CTRL-SPACE). With the selection tool, you can move, resize, 

            rotate, change   the  color  and edit its properties with  the  active  property  bar. With the  

            activeroperty bar, you can change the font, size, set bold, set italic and alignment. 
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Corel Draw 
 

 

Adding paragraph text. To add paragraph text to our document, choose the text tool and click 

and drag somewhere in your document. This creates a rectangle with a dotted outline. If you type 

your text into this rectangle, you have paragraph text. Although Coreldraw has a lot of word 

processing functionality, it is usually more convenient to write your text with a real word processing 

application, such as MS Word. You can copy your text from MS Word and paste it into coreldraw. If 

you do so it is important to use 'Paste Special' in Coreldraw ("edit>paste special") and then choose 

Rich Text Format, otherwise you will paste it as a word document and you can not edit it with 

Coreldraw tools. 
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 IN COREL DRAW TEXT TOOL FOR PRACTICE EXERCISE  
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Lesson no. 7: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
  

    Tables Tool - Draw, select, and edit tables. Click the Table tool in the toolbox, and drag on 

the page to create the table. Click Table > Create new table. In the Create new table dialog 

box, type the number of columns and rows, as well as the overall size of the table. 

 

Create a table with the settings shown below by performing one of the following actions: 

1.           Click the Table tool in the toolbox, and drag on the page to create the table. 

2.           Click Table > Create new table. In the Create new table dialog box, type the number of  

3.           columns and rows, as well as the overall size of the table. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DIMENSION TOOL FLYOUTS 
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In Corel Draw Working with Dimension Lines 

Corel DRAW allows you to easily add various types of dimensioning lines and call-outs. By 

using dimension lines, you can indicate the distance between two points in a drawing or the 

size of objects. By default, dimension lines and the measurements shown on the lines change 

when you change an object’s size.  

There are 4 types of Dimension line tool in Core Draw 

1. Parallel dimension   

2. Vertical or horizontal dimension    

3. Angular dimension lines measure angles. 

4. Segment dimension tool 

 Parallel Dimension - Draw slanted dimension lines. Parallel dimension lines measure  

  the actual distance between two nodes. Click to place the starting point, and drag to where  

  you want to place the endpoint of the dimension line. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
         Horizontal or Vertical Dimension tool - Draw horizontal or vertical dimension 

             lines. Vertical or horizontal dimension lines measure the vertical (y-axis) or horizontal  

            (x-axis) distance between any two nodes. Move the pointer to position the dimension line, 

            and click to place the dimension text. 
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     Angular Dimension tool - Draw angular dimension lines. Angular dimension lines  

     measure angles. 

                  • Click where you want the two lines that measure the angle to intersect, and drag to  

                where you want the first line to end. 

              • Click where you want the second line to end. 

              • Click where you want the angle label to appear 

 

 

 

 

 

 

 

 

 

 

 

                 Segment Dimension tool -Display the distance between end nodes on single or. 

   multiple segments. With the Segment dimension tool, you also have the ability to 

                 measure the distance between the two most distant nodes in multiple segments. Using 

                 the Segment dimension tool , marquee select the segments, drag to position the  

                 dimension line, and click where you want to place the dimension text. You can also 

                 measure successive segments automatically by clicking the Automatic successive  

                 dimensioning button on the property bar, and marquee select the segments that you  
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                  want to measure. Drag to the location where you want to place the dimension text and 

                 release. 

                 • Click the segment that you want to measure. 

                 • Move the pointer to where you want to position the dimension line, and click where you  

                 want to place the dimension text. 

 

 

 

 

 

 

 

 

 

 

                3-Point Callout tool - Draw labels and speech bubbles. Call-outs can be easily 

                  created to identify parts of a drawing or to draw attention to specific parts of a design. 

   

                    In the toolbox, click the arrow in the bottom-right corner of the Parallel dimension tool   

                    button to open the Dimension tools flyout, and click the 3-Point callout tool. 

 

                  • Click where you want the first callout segment to start, and drag to where you want 

                    the first segment to end. 

                 • Click where you want the second segment to end. A text cursor is displayed at the end 

                   of the callout line, indicating where to type a label for the object. 

                 • Type the callout text. 

                  You can also change the callout style and the distance between the leader line and the 

                   callout text. This is done from the interactive property bar. 
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IN COREL DRAW FOR TABLE TOOL PRACTICE EXERCISE 
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Lesson no. 8: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
 
Connector Tools in Corel Draw Flyout 
 
 
 
 
 
  

 
 
 
 
Connector Tools used in Corel Draw 
 

You can draw connector lines between objects. Objects stay connected by these lines even 
when you move one or both objects. Connector lines, which are also known as "flow lines", 
are used in technical drawings such as diagrams, flowcharts, and schematics. For information 
about drawing flowchart shapes, see Drawing predefined shapes.  
 
There are three types of connector lines that you can draw in Corel draw. 
 
1- Straight-line connector tool —  

2- Right-angle connector tool — 

3- Rounded right-angle connector tool — 

 

      Straight-Line Connector tool - Draw a straight line to connect two objects. 

                   When you move objects, their connector lines remain attached. You can draw callout 

      lines that label and draw attention to objects. 

 

 

 

 

 

 

 

 

 

 

 

http://product.corel.com/help/CorelDRAW/540223850/Main/EN/Documentation/CorelDRAW-Drawing-predefined-shapes.html#1000108
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             Right-Angle Connector tool - Draw a right angle to connect two objects. When you 

                    move objects, their connector lines remain attached. Right-Angle Connector tool to create 

               a connector line containing vertical and horizontal segments at right angles 

 

 

 

 

 

 

 

 

 

 

  

                    Right-Angle Round Connector tool - Draw a right angle with a rounded corner to  

                   connect two objects. Right-Angle Round Connector tool to create a connector line 

              containing vertical and  horizontal elements at rounded right angles. 
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You can change also in straight line connector 

 

               Edit Anchor tool – Modify the connector line anchor points of objects. Edit Anchor tool  

              to create a  connector line Containing vertical and horizontal elements at rounded right  

              angles. To change the direction of a connection line by using the Edit Anchor tool. 

              In the toolbox, click the Edit anchor tool . 

              Click the anchor point from which you want to change the connector line direction. 

                  On the property bar, click the Adjust anchor direction button. 

 

By default, anchor points that you add to an object are not available as snap points for a connector 

line when the object is moved around in the drawing. To make an anchor point available as a snap 

point, select it with the Edit anchor tool, and click the Auto anchor  button      on the property bar. 

 

To move or delete an anchor point 

 

 

 

Move a horizontal segment in an angled 

connector line 

 

 

Using the Shape tool     select a connector line, 

and drag the middle node on the segment that 

you want to move. 

Move an end point of an angled connector 
line 

Using the Shape tool      , drag an end node 

along the edge of the object. 

Add a segment in an angled connector line Using the Shape tool , drag a corner node. 

Delete a segment in an angled connector 
line 

Using the Shape tool    , drag a corner node 
over the closest corner node. 
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1.           

 
 

 

Connectors Practice Exercise 
 
 
 
 
 
 
 
 

To 
 

Do the following 

Move the anchor anywhere along the 
perimeter of an object 

Using the Edit anchor tool , drag the anchor 
point to another point on the perimeter. 

Move the anchor to the middle of an object Drag the anchor point to any point inside the 
object. 

Delete an anchor On the property bar     ,  click the Delete 
anchor button 
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Lesson no. 9: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
 
Effect or Interactive Tools in Corel Draw Flyout 

 
 
 
 
 
  

 
 
 
Interactive Tools used in Corel Draw 
 

The effect tools can be used to add special effects to objects; at first glance many of these 

effects will seem too pronounced to be useful. But with some trial and error many of these 

effects can be applied subtly and actually improve the illustration. 

      Interactive blend tool - The blend tool blends two objects by drawing intermediate 

shapes. At first glance this seems to be useless for anything but simulating evolution. 

Fortunately this first impression is very wrong, it is actually the most powerful tool Vector 

illustration packages have for making photorealistic illustrations. By blending similar objects on 

top of each other, which differ only slightly in shape and color, all kinds of complex shading 

effects can be created. This tool is an interactive one that creates a progression of objects 

shape, size, and colors between the two objects selected with the tool. Users can control the 

angle and acceleration of the blend, as well as how many steps will be created from point A to 

point B. 
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         The Interactive Contour Tool- This interactive tool allows you to create a series of 

concentric shapes within or around a selected object according to the settings defined either in 

the Contour docker or the Property Bar. This tool is related to the blend tool, but instead of 

blending two shapes, it blend the outline of a single object to a larger or smaller version of the 

object. It adds a series of evenly spaced copies of the outline inside or outside of the outline. 

Since these added contours also blend in color, a lot of contours closely spaced together result 

in a smooth effect. The effect is applied by selecting the Interactive Contour Tool, and clicking 

and dragging on the object to which you want to apply the effect. Dragging to the inside of the 

object results in contours added inside the object and dragging outwards from the object, 

results in contours added to the outside. The exact number of contours added and the spacing 

in between contours can be set using the property bar. On the property bar it is also possible 

to select the color for both fill and outline where the contour blends to. 

 

 

 

 

 

 

 

 

 

 

 

 

  

         Interactive Distortion Tool- This tool transforms objects by giving you the option to 

apply effects such as push and pull, zipper, or twister distortions through settings found in 

the Property Bar. This tool distorts the outline of objects. When applied without care, it 

completely alters the shape of objects, but when applied subtly, it can make objects look less 

geometric and appear more natural. To use it, select a type of distortion from the active 

property bar, and click and drag on the object to which you want to apply the distortion. 
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There are three main types of distortion:- 

1. Push and pull distortion, 

2. Zipper distortion   

3. Twister distortion  

they are illustrated in the example above. 

Drawing wiggly unconformities 

A typically geological usage of the Zipper distortion is to create a wiggly line, for representing 
unconformities. To do so, select the line, which you want to become wiggly, and apply Zipper 
distortion. Next on the active property bar, click on the Smooth distortion button(     ) and next click 
on the Center distortion button(     ). You may need to adjust the Zipper distortion amplitude and 
frequency.  (                               ) 
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      Interactive Drop Shadow Tool This interactive tool allows you to create, place, 

modify, and copy a drop shadow effect on objects within your documents. Define settings 

manually or drag the shadow out from the object itself with the tool to create drop shadows 

quickly and easily. You can save and load preset drop shadows as well, speeding up your 

productivity within the program. 

This tool adds drop shadows to objects. Drop shadows are very useful, they give the illusion of 

depth and quickly make a drawing look more 'finished'. A drop shadow behind text, makes it 

easier to read over a noisy background. Select the tool, and click and drag on the object to 

which you want to apply the shadow. The way you drag the mouse determines the type of 

shadow. The type of shadow can also be selected from property bar, from the presets list. The 

drop shadow effect can also be used for glow effects, for the strongest effect, choose 'outside 

direction' in the 'Drop Shadow feathering direction. 

1.           

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

    Interactive Envelope Tool- This tool allows you to change the shape of an object by 

manipulating nodes surrounding the object in an envelope or bounding box instead of the 

object's nodes themselves. This tool bends entire shapes or groups of shapes, by modifying 

their enveloping shape. It is useful to manipulate the entire shape of complex objects such as 

text objects, or groups of objects. Choose the Interactive Envelope tool, and select the object 

you want to alter. An enveloping rectangle with eight nodes appears. Drag the nodes to alter 

the shape of the envelope, and the object itself will change shape, to match the envelope. 
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 Interactive Extrude Tool- This tool is used to extrude 2-dimensional objects into 3-

dimensional objects. Select the tool and click and drag on the object you want to extrude. 
Different types of perspective and shading are available from the property bar. This tool 
allows you to convert a flat object into a 3D object with a number of options found within either 
the Property Bar or the Extrude docker. 

. 
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     Interactive Transparency Tool- With this tool it is possible to make objects (partially) 

transparent. Besides making it easy to draw transparent things like glasses, transparent objects 

can be used to simulate all kinds of effects like smoke, reflections and complex shading effects. 

Transparency effects can be applied to objects by selecting the objects with the interactive 

transparency tool and then choosing the type of transparency from the property bar. This tool 

allows users to interactively create or modify an object or curve's transparency properties either 

on the object itself or in the Property Bar. 

There are nine types of transparency: 

• Uniform: the object's transparency is the same everywhere. 
• Linear, Radial, Conical, Square: the transparency fades from transparent at one side to 

opaque on the other side. There are four types of gradient which determine the shape of the 
fading. When you apply a gradient transparency to an object, a white square and a black 
square will appear, connected by a straight line. The white square determines the position 
of the opaque area, and the black square determines the position of the transparent area. 
These squares can be dragged to move the opaque and transparent areas. 

• Two Color pattern, Full color pattern, Bitmap pattern and Texture: for these types of 
transparency the distribution of the transparent and opaque areas is determined by the dark 
and light areas in the texture or pattern chosen. 

A quick way to add linear gradient transparency to an object is to click and drag on the object 

with the Interactive Transparency tool. Linear gradient transparency is probably the most 

useful type of transparency, it can be used for fading and shading objects and for blending two 

bitmaps. 
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Lesson no. 10: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
 

    Color Eyedropper tool-              Sample colors, and apply them to objects. These 

tools allow you to copy properties from one object to another. Click on an object A with the 

eyedropper tool to sample its properties and next take the paint bucket tool and click on 

another object B to transfer the A' sampled properties to B. 

Although eyedroppers tools in graphics software are mostly used to sample colors, the 
eyedropper tool in CorelDraw can sample a lot more properties beside color; such as line 
style, skew, rotation, effects applied to the object and fonts for text objects. You can select 
the properties which are sampled and transferred with the active property bar. A quicker 
way to transfer some basic properties from one object to another  
 

 

 
 
 
 
  

 
 
 

   

 

   

             Outline Pen tool Flyout  
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 Outline Pen Tool- The outline menu allows you to format lines. Properties that can be 

changed include colour, thickness, arrows, dotted lines, corners and calligraphic effects. 

 

 

 

 

 

All properties can be accessed through the Pen dialog menu: 

 

 

 

 

 

 

 

 

 

  

          Color: Select a color from the drop down menu 

   Width: Set the thickness of the line. A hairline is a very thin line, which is barely visible on 

             prints, for printing use lines of at least a point thickness. 
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Style: make a line dotted (.....), striped(----) or a mixture(..-..-..). Edit style allows you to make 

your own style of dots and stripes. 

 

 

 

 

Corners: Choose between angular, rounded or cut off corners. 

 

 

 

Line Caps: Determine the style of your line endings; straight ending at the node, rounded or 

straight ending slightly away from the node. Line caps also effects the dots or stripes which 

make up a dotted line. 

 

 

 

Arrows: Add an arrowhead to the beginning or ending of your line. The left box selects an 

arrow for the beginning of the line, the right box for the end of the line. 

 

 

 

Calligraphy: Make a line look calligraphic, it changes thickness depending on the angle. Set 

a nib shape by clicking and dragging the mouse in the nib shape area. A very thin nib will give 

a strong effect. 
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Behind fill: Only shows the outline on the outside of the object, not in front of the fill. This 

is very useful for text objects, it allows you to add a thick outline to text, without ruining the 
insides. The thick outline can make a text stand out over a noisy background. 
 

 

 
 
 
 
 
 

 

Scale with image: Determines if the thickness of the object's outline is changed when the 

object itself is changed in size. This option is very useful when the thickness of your lines is 

important and you want to make large adjustments in size. 

If you are like me you will not think about this option until your drawing is nearly finished, but 

you then suddenly realize you need to resize your entire drawing and it would be very useful 

to turn this option on for every object. You can do so with the replace objects function. Go to 

replace objects: " Edit > Find and Replace > Replace objects " choose "Replace outline 

pen properties", click next. In the find section select "scale outline with image", select OFF. 

In the replace section select "scale outline with image", select ON, click finish. Click 

the Replace All button and you are done, all objects no scale there outline when they are 

resized. 

The outline pen menu allows you to set every line properties at once, but there 
are faster ways to change most line properties: 

• color: Just right click on a color in the palette and the selected object's outline will change 

to that color. For no outline, right click on the white square with a diagonal cross in it. 

• Thickness Seven predefined line thicknesses are directly available form the outline 

foldout menu. The size range from hairline to 24 point thick. 
• Thickness, style and arrows are often available from the active property bar when you 

select a line object. 
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Lesson no. 11: Corel Draw Toolbox 

 
Corel Draw Tool Box and Function Working with Toolbox:- 
 

     

Fill tool Flyout  

 
 

 
 
 
 
  

 
 
 

   

 

 

   
Besides clicking on a color in the palette, there are many other ways to add color to objects. The fill 

menu gives access to almost all the different fills in CorelDraw. Besides uniform colors, 

CorelDraw can fill objects with various gradients, patterns, textures and postscript fills. 

  

Fill color dialog- This dialog allows you to give a uniform to an object. The difference    

 between this menu and just clicking a color on the palette is that this menu allows you to fine 

tune your color. You can choose from many different color models, of which RGB and CMYK 

are the most important. You can enter your as a numeric value in one of these models. There 

are two types of color mode in Corel Draw :- 

1- RGB- Red, Green & Blue 

2- CMYK- Cyan, Magenta, Yellow & Black 

 

 

 

 

 

 

 

 

http://personal.strath.ac.uk/yannick.kremer/Corel/Fill.html#uniform
http://personal.strath.ac.uk/yannick.kremer/Corel/Fill.html#fountain
http://personal.strath.ac.uk/yannick.kremer/Corel/Fill.html#pattern
http://personal.strath.ac.uk/yannick.kremer/Corel/Fill.html#texture
http://personal.strath.ac.uk/yannick.kremer/Corel/Fill.html#postscript
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Fountain fill dialog- With this menu you can make gradient fills for your objects. The fills 

range in complexity, from simple 2 color fills, to gradient fills consisting of many different colors. 

There are four types of fountain fill: Linear, Radial, Conical and Square. Linear fountain fills 

blend colors in a single direction. Radial fills blend colors from the centre to the outside of the 

object. Conical blends colors as if they were distributed along the side of a cone. Square 

fountain fills blend colors along from the centre outwards along a square. 
 

 

 

 

 

 

 

 

 

 

The Fountain fill dialog allows you to create complex fills, but most fountain fills can be created 

easier and faster with the Interactive fill tool. 

Pattern Fill dialog- This menu allows you to add pattern fills to your objects. Pattern fills   

    consist of small images replicated to fill the objects. There are three kinds of patterns in 

    Corel draw: 2 color, Full color and bitmap. 
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• 2 color patterns: These patterns are made of small raster images repeated over and 

over. You can click the pattern filled square to select a preset. To create your own, click 

the Create button. On the grid left click to make a grid cell black and right click to make it 

grey again. It is to use this for patterns with only horizontal or vertical lines, and no diagonal 

lines, since diagonal lines show a very ugly aliasing. If you do need a pattern with diagonal 

lines, draw them vertical or horizontal and rotate your entire pattern with the rotate option in 

the Pattern fill dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Full color patterns: These patterns consist of small vector drawings repeated over and 

over. These patterns can contain as many colors as you want, and because the patterns are 

vector based, they can be scaled without loss of sharpness. Their disadvantage is that you 

can only choose the colors when you create the pattern, you can not change it afterwards. 

Some presets are available, but if you want to make your own, you have to go back to 

Coreldraw's drawing tools. The easiest way is to draw your pattern in Coreldraw, and then 

go to "Tools > Create > Pattern", choose full color. The mouse cursor changes into a 

crosshair, use the mouse to draw a rectangle around your pattern. When you release the 

mouse button, a message will appear, asking you if you want to create a pattern from the 

selected area, click yes and enter a filename for your pattern. Now your pattern is available 

from the list in the Pattern fill dialog. 
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• Bitmap patterns: This allows you to use bitmap images as a pattern fill. Some presets 

are available, but you can also load your own bitmap images (photos for example)  

 

 

 

 

 

 

 

• Texture Fills- Texture fills are complex fills, probably generated using a fractal algorithm. 

They work great for giving a natural rough look to your drawings. A good approach to finding 

the right texture fill, is to look at some samples, adjust the colors and press the preview 

button until you see a texture you like. The preview button changes some settings each 

time, generating new textures. The lock symbols next to the options control which options 

are randomized. 
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• Postscript Fills- 

Postscript fills are rarely used nowadays. These are complex fills, created in the postscript 

printer language. The postscript fills can be quite nice, but are very hard to edit. They exist 

mainly for compatibility with postscript files. 

 

 

 

 

 

 

Interactive Fill Tool and Interactive Mesh Fill Tool 
 

 

The interactive fill tool allows you to add the same fills to objects as the normal fill tool, but in  

an interactive way; you set the fills properties in an interactive way. This is especially useful for 

fountain fills. 

Interactive fill tool 

Applying a fountain fill with the interactive fill tool 

Just click and drag on an object with the interactive fill tool. The object will become filled with a 

fountain fill from the objects color to white. The direction of the fountain fill is determined by the 

direction in which you dragged the mouse. 

 

 

 

 

 

You can edit the fountain fill by dragging the two squares, to change the direction and 

position of the fountain fill. You can change the colors used for the fountain fill in the property bar. 

You can also drop a new color from the palette onto one of the squares, to change the color. If you 
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drop a color on the line between the squares, the color will be added to the fountain fill as a new 

color. 

Besides linear fountain fills, there are other types: radial, conical and square. To change your 

linear fountain fill into another type of fountain fill, select it from the active property bar. The 

behavior of the squares changes slightly between the different types of fountain fill, but in general it 

works the same for all types. 

Applying other fills with the interactive fill tool 

When you select an object with the interactive fill tool, you can apply other fills than fountain 

fills, with the active property bar. Pattern, texture and postscript fills are available from the 

dropdown menu in the property bar. 

With these fills, less property can be set interactively; most properties are set through the active 

property bar. When you apply such a fill, a dotted rectangle appears, with 4 marker symbols. 

These symbols allow you to set the size, rotation, skew and displacement of the pattern tiles 

interactively. Increase the size of the square by dragging the top right (circle) marker, increases the 

pattern size. The two squares on the sides allow you to skew the pattern. And dragging the center 

marker displaces the pattern as a whole. 

 

 

 

 

 

Interactive mesh fill tool 

The mesh fill is a very complex kind of fountain fill, whereby the blending colors' distribution is not 

limited to lines. The colors can be anywhere inside the object. When you select an object with the 

interactive mesh fill tool, it will become overlain with a mesh lines and nodes. You can drag and 

drop colors from the palette onto zones or nodes of the mesh. The colors will automatically blend 

with the other colors in the mesh. The mesh itself can be node edited, to make allow for a more 

precise distribution of the colors. This is a complicated tool, which requires some practice, but can 

achieve impressive results. 
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Lesson no. 12: Corel Draw Toolbox 

 
About Toolbars -  When we start Corel draw, there are 4 toolbars are below:- 

 
1- Title Toolbar 
2- Menu Toolbar 
3- Standard Toolbar 
4- Property Toolbar 

 
Title Bar-   It Displays the name of the program, the name & Location of the currently active word 

document, the Control menu icon, the Maximize button, the Minimize button and the Restore and 

Close button. 

 

Menu Bar- The Menu Bar is positioned below the Title bar. It contains options like File, Edit, 

View and Format etc. Each of these menu bar items has drop-down menus. [Drop-down menu 

comprises a list of options which drops down when you click on the menu bar item] 

 

Standard Toolbar- The standard toolbar contains buttons that are shortcuts to many of the 

menu commands. It provides access to common windows commands, such as New, Open, Save 

and Print etc. 

 

Property Bar- This bar has icons and drop-down lists that change dynamically, depending on 

what is selected and which tool is active. It displays the most commonly used functions that are 

relevant to the active tool or to the task you're performing. Although it looks like a toolbar, the 

property bar contents changes depending on the tool or task. For example, when you click the 

Text tool in the Toolbox, the property bar displays only text related commands, such as 

text, formatting, alignment, and editing tools. 

 

After complete Toolbox From here we start Menu Bar-: There are 12 Menus in a 

Corel Draw Window: 

1. File 

2. Edit 

3. View 

4. Layout 

5. Arrange 

6. Effects 

7. Bitmaps 

8. Text 

9. Tables 

10. Tools 

11.  Windows 

12. Help 
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File Menu- Drop Down list 

 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

 

 

 

NEW - Creates a “ New Blank document“ (Shortcut- Ctrl+ N) 

 

NEW FROM TEMPLATE - Creates a new document by using existing designed formats. 

 

NEW FROM TEMPLATE - Creates a new document by using existing designed formats. 

 

OPEN - Opens an existing or Saved document. (Shortcut – Ctrl+O) 

 
CLOSE - Close the active document without exiting the program. 
 

SAVE - Saves the active file with its current file name, location and file format.( Shortcut- Ctrl+S)  

SAVE AS  - Saves an already saved file with different name and Format. .( Shortcut- 

Ctrl+Shift+S)  

REVERT - Revert to the last saved version of a drawing. 
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ACQUIRE - IMAGE Lets you scan something using the installed scanner. 

 

IMPORT  - Lets you import a bitmap or any other file into a document either directly or by linking 

it to an external file. When you link to an external file, edits to the original file are automatically 

updated in the imported file. (Shortcut- Ctrl+I) 

 

EXPORT - Lets you export and save images to a selected file format that can be used in other 

applications. For example, you can export a file to the Adobe Illustrator (AI) or GIF format. 

(Shortcut- Ctrl+E) 

 

SEND TO   -Sends your active documents directly to various locations like My Documents, Mail 

Recipient, Creates shortcut for your file on desktop etc. 

 

PRINT  - Prints active document 

 

PRINT MERGE You can use the Print merge wizard to combine text with a drawing. 

For example, you can personalize an invitation by printing a different recipient's name on each 

invitation. PRINT PREVIEW Shows how a document will look when you print it. 

 

PRINT PREVIEW  -Shows how a document will look when you print it. 

 

PRINT SETUP  - Lets you change the print settings. 

PREPARE FOR SERVICE BUREAU -  You can use the Prepare for service bureau wizard 

to guide you through the process of sending a file to a service bureau. The wizard simplifies 

processes such as creating PostScript and PDF files; gathering different pieces required for 

outputting an image; and copying the original image, embedded image files, and fonts to a user-

defined location. 

PUBLISH TO WEB - It provides several options for publishing your document or selection for 

use on the World Wide Web. You can choose several options such as image format, HTML layout, 

export range, and file transfer protocol (FTP) site parameters for uploading your files.  

PUBLISH TO PDF - Lets you export or save your file in a PDF file format. The Portable 

Document Format (PDF) is a file format designed to preserve fonts, images, graphics, and 

formatting of an original application file. Using Adobe Acrobat Reader and Adobe Acrobat 

Exchange, a PDF file can be viewed, shared, and printed 

DOCUMENT INFO - Gives you detailed information about your active document. 

EXIT - To close the active document and exit the Corel draw only. (Alt+F4) 
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Lesson no. 13: Corel Draw Menu Bar 

 
Edit Menu- Drop Down list 

 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

 

 

 

Undo - To step backward the steps you did.t“ (Shortcut- Ctrl+ Z) 

 

Redo - To step for word the steps you did using the undo. (Ctrl+Shift+Z) 

 
 

Repeat Move - To repeat the last step you did.. (Ctrl+R) 

 

Cut- To cut any object or text. Cut the Selection and put it on the clipboard. (Shortcut – Ctrl+X) 

 
Copy - To copy any object or text. Copy the Selection and put it on the clipboard. 

(Shortcut – Ctrl+C) 

 

Paste - To paste the object you copied or cut.(Shortcut- Ctrl+V)  

Delete - To delete the selected object or picture. 
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Duplicate - To make a duplicate copy of the selected object (Shortcut- Ctrl+D) 

 

Clone-It also makes a duplicate copy of the selected objects..  

 

Copy Properties From   -To copy the properties (i.e. fill color, outline color and outline style) 

from one object to another 

 

Step & Repeat  - Prints active document.  (Shortcut- Ctrl+Shift+D) 

 

 

Overprint outline Overprint is a way of combining colors when dealing with subtractive colour 

spaces such as CMYK. When you print non-transparent, overlapping colours, the top colour knock 

outs the area underneath. • Overprint is a feature that especially in Adobe Illustrator, InDesign 

and Corel Draw needs special attention. 

 

Overprint Fill  - Overprinting Fill means that one color gets printed directly on top of 

another color. Sometimes in printing, it makes sense to allow the top objects in a piece to print 

directly on top of other fully printed objects. 

 

Object Hinting- Applying object hinting. Object hinting allows you to improve object rendering 

by adjusting the display of an object so that it lines up with the pixel grid. For example, if you're 

creating a button for the Web, you can enable object hinting to ensure the object appears clean 

and sharp when exporting it as a bitmap.. 

Select All - Select all objects in a drawing by double-clicking the Pick tool. This action selects all 

objects on the active page and on the desktop, the area surrounding the drawing page. 

 (Shortcut- Ctrl+A) 
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   ind & Replace Looking for words for any replacements or spelling correction in long texts is 

very simple in CorelDRAW. Go to: Edit > Find and Replace > Find text  In the pop-up window on 

the field "Find", type the text you need to find. 

 

 

 

 

 

 

 

 

 

 

Insert  Barcode - From the Edit menu select Insert Barcode. 

Corel DRAW offers a large selection of barcodes to choose from. In this example we will. 

select UPC(A)which is considered the most common barcode used 
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Enter an 11 digit number and click Next. In the window you will be able to select the resolution and 

choose dimensions. For the purposes of this example, I'll leave the settings at the default. 

 

 

 

 

 

 

 

 

 

 

 

Click Next again. Leave these settings default as well and click Finish. 
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As you can see in the Object Manager docker, the barcode is an OLE object. This format does not 

allow for very much freedom when editing so it will need to be converted into a vector object. 

To do this, select the barcode and then go to File > Export. Put a check mark in Selected 

Only and then Choose CMX as the export file type. 

7. After you have exported the CMX file, you can delete the barcode in Corel DRAW and then re-
import the CMX file. 
 
When you have re-imported the file, click on the very edge of the graphic and you will see nodes 
appear at all four corners. This is because there are two rectangles surrounding the barcode, a 
border and a white background. Since most packages don't require that a barcode have a white 
background, we will remove them 

Insert New Object - To insert any object or file from outside using various applications e.g.:- 

MS-paint, MS-word, Photoshop etc. 

 

Properties – Properties option in Edit Menu used for if you create an object, the property of that 

object is found in the same place as the color & outline etc. You can easily change setting any 

object through this option. (Shortcut- Alt+Enter). 

 

 



 

www.dotnetinstitute.co.in           Call us at - 011-4004 0815 

Corel Draw 
Lesson no. 14: Corel Draw Menu Bar 

 
View Menu- Drop Down list 

 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

 

 

 

Simple Wireframe - To view the documents using wire from in which you can only see the out 

lines of the objects. 

 

Wireframe - It works just like the simple wireframe. 

 
Draft - To view the document with colors low quality. 

 
Normal- To view the document with colour in good quality.  

 

Enhanced- To view the document with colour in very good quality.  

 

Full screen: - To view the documents on the full screen. (Shortcut- F9) 

 

View Menu 
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Preview Selected Only : - If this option is selected you can view the objects on the full screen 

these are selected. 

 

Page sorter view : - To view the pages of your document in a sorted order. 

 

Ruler: - If this option is selected you can view rulers into your document. 

There are two types Rulers in Corel Draw -;- 

➢ Horizontal 

➢ Vertical 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Grid: - To view the document with a graphed pattern. 

 

Guidelines: - If this option selected you can view guidelines into your document.. 

 

Show: - It contains various options from which you can set various views for your page in a 

document. 

 

Snap to grid: - The object will move according to grid, if this option is selected. 
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Snap to guidelines : - The object will attaches its self to the guidelines when it is moved near 

about it (if this option is selected) 

  

Snap to objects : - The objects will attaches itself to another object, if it is moved near about it 

(if this option is selected). 

 

Layout  Menu- Drop Down list 

 

 

 

 

 

 

 

 

 

 

 

 

 

Insert Page: - We can use this option to insert number of pages into your document. 

 

 

 

 

 

 

 

View Menu 
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Delete page: - We can use this option to delete number of pages from your document. 

 

 

 

 

 

 

Rename page : - We can use this option the rename the active page into our document. 

 

 

 

 

 

 

Duplicate page;-  We can use this option for the Duplicate page. 
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Go to page : - Using this option you can reach the specified page into your document. 

 

 

 

 

 

 

 

 

 

Switch page orientation : - Using this option we can inter change between the pages layout 

(i.e. landscape or portrait).  
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Page setup: - We can use this option to set the. It is a most important option in Layout menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Page background : - By use this option we can page colour or bitmap images. 
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Lesson no. 15: Corel Draw Menu Bar 

 
Arrange Menu- Drop Down list 

 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

Transformations: - Using this option you can apply various transformations (i.e. scaling, 

rotating, positioning etc.) on the selected object. You can apply these transformation on there’s 

duplicates also.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Arrange Menu 
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Clear transformation: - Using this option you can clear the transformations you used on the 

object or picture. 

 
Align and distribute : - Using this option you can adjust various alignment for the selected 

objects like center, left, right, top, bottom etc. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Order: - It contains various options which can be used to send the selected object towards back 

or bring the selected objects for wards. 

 

 

 

 



 

www.dotnetinstitute.co.in           Call us at - 011-4004 0815 

Corel Draw 
 

 

 

 

 

 

 

 

 

 

 

 

 

Group: - Using this option you can group 2 or more selected objects.(Ctrl+G) 

 

  

Individual objects joint
 in a one place called 

a grouping

Ctrl+
G
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Ungroup: - Using this option you can break the group of two or more selected objects. 

Ungroup Short command – Ctrl+U 

 

 

 

 

 

 

 

 

 

Ungroup all : - It break all the groups one at a time. 

Combine : - It combines the selected objects and removes the merged area. 

Combine Option Short Command is ( Ctrl+L) 

 

 

 

 

 

 

 

 

 

 

Ungroup Option 
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Break apart : - It breaks the combined objects and returns them to the previous conditions. 

Break apart shortcut (Ctrl + K) 

Lock: - It locks the selected object which cannot be moved or coloured 

 

Unlock : - It unlocks the selected locked object 

. 

Unlock all : - It unlocks all the locked objects. 

 

Shaping  Drop down list 

 

 

 

 

 

 

  

 

Weld : - It converts two selected objects to one by welding them. 
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Trim : This option can be used to extract any figure out of two selected objects. 

 

Intersect :  This option can be used to extract the merged area of out of any two selected 

objects. 

 

Convert to curves : - It converts the shape to curve. Shortcut (Ctrl + Q) 

 

Convert out lines to curves : - It converts the outlines to curve. 

Shortcut (Shift+Ctrl+Q) 
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Lesson no. 16: Corel Draw Menu Bar 

 
 Effects Menu- Drop Down list 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

 

 

 

Adjust : - It contains various types of settings from which you can adjust the gamma level, color 

lever or brightness and contrast settings for the picture or a bitmap. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Effects Menu 

Effects Menu 

Adjust 

O riginal

A fter change
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Transform - It contains various options from which can invert the colours of your picture or can 

all a posterize the bitmap. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Artistic media blend (contour- Ctrl+F9) (envelop-Ctrl + F7)  extrude: - It cantains 

the some settings those you use from the property bar, when the artistic media tool or any other 

effect tool is select. 

 

Lens :Using this option you can convert any object like rectangle, square etc to a lens with 

various effects like magnifying, fish eye, invert etc. (Shortcut Alt + F3) 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

O rig in a l

After ChangesAfter Changes

After Changes

Delnterlace
Option

Invert
Option

Posterize
Option

Effects Menu Adjust 
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Power clip: - You can use this option to place the selected object or picture inside any other 

objects (like square, rectangle etc) or can even edit it inside that object or extract it from that 

object. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clear effect : - This option can be used to clear all the effects from the object which were 

created using effects tools.  

 

Copy or clone effect; - Bath this option, consists various sub options, those can be used to 

copy the effects (created by effects tools) from one object to another.  

 

Bitmaps:- Convert to bitmap This option can be used to convert the selected objects or figures 

to a bitmap or a picture 
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Lesson no. 17: Corel Draw Menu Bar 

 
 Bitmaps Menu- Drop Down list 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

 

 

Bitmaps:-  
 
Convert to bitmap: This option can be used to convert the selected objects or figures to a 

bitmap or a picture. 

Using the Image Adjustment Lab: The Image Adjustment Lab lets you correct the colour 

and tone of most photos quickly and easily.  

 

 

 
 

 

 

 

Bitmaps Menu 
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1. Rotation tools  

2. Pan tool  

3. Zoom tools 

4. Preview Modes  

5. Select white point  

6. Select black point  

7. Undo, Redo, and Reset  

8. Snapshots 

9. Sliders  

10. Hint for current tool  

11. Histogram  

Straightening bitmaps :The Straighten image dialog box lets you straighten bitmap images 

quickly. This feature is useful for straightening photos that were taken or scanned at an angle.  

 

  

   

 

 

 

 

 

 

 

Straighten image dialog box;- 

1. Preview window  6. Options for cropping and resampling  

2. Rotation tools  7. Reset button  

3. Pan tool  8. Grid  

4. Zoom tools  9. Hint for active control  

5. Rotate Image controls  10. Grid control  
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The Straighten image dialog box lets you rotate an image by moving a slider, typing a rotation 
angle, or using the arrow keys. You can specify a custom rotation angle from -15 to 15 degrees.  

Mode : This option contains various modes which, can be used to convert the bitmap or a picture 

from one mode to another (like block and white, Grayscale, dust one, lab color, RGB(red green, 
blue), CMYK(cyan, magenta, yellow, kala). 

 
 
 
 
 
 
 
 
 
 
 

Trace Option - It is an important option in Bitmaps Menu. You can trace image and after that 

used ungroup option you can used images individual parts. Like this below  

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Applying special effects in bitmaps  You can apply a wide range of special effects to 

bitmaps, such as three-dimensional (3D) and artistic effects.  

 

 

Mode 
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Special effect 
category  

Description  

3D Effects  Let’s you create the illusion of depth. Effects include Emboss, Page Curl, 
and Perspective.  

Art Strokes  Let’s you apply hand-painted techniques. Effects include Crayon, 
Impressionist, Pastels, Watercolor, and Pen & Ink.  

Blur  Let’s you blur an image to simulate movement, speckling, or gradual 
change. Effects include Gaussian Blur, Motion Blur, and Zoom.  

Camera  Let’s you simulate the effect produced by a diffusion lens  

Color Transform  Let’s you create photographic illusions by using color reduction and 
replacements. Effects include Halftone, Psychedelic, and Solarize.  

Contour  Let’s you highlight and enhance the edges of an image. Effects include 
Edge Detect and Trace Contour.  

Creative  Let’s you apply various textures and shapes to an image. Effects include 
Fabric, Glass Block, Crystallize, Vortex, and Stained Glass.  

Distort  Let’s you distort image surfaces. Effects include Ripple, Blocks, Swirl, and 
Tile.  

Noise  Let’s you modify the graininess of an image. Effects include Add Noise, 
Remove Moire, and Remove Noise.  

Sharpen  Let’s you add a sharpening effect to focus and enhance edges. Effects 
include Adaptive Unsharp, High Pass, and Unsharp Mask.  

Plug-ins  Let’s you use a third-party filter to apply effects to bitmaps in CorelDraw. 
An installed plug-in appears at the bottom of the Bitmaps menu.  
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3D Effects – By using this option we can apply multiple effects on images. 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
Art Strokes:- Apply hand-painted techniques. Effects include Crayon, Impressionist, Pastels, 

Watercolor, and Pen & Ink. 

 
 
 

 

 

  



 

www.dotnetinstitute.co.in           Call us at - 011-4004 0815 

Corel Draw 
Blur:- you blur an image to simulate movement, speckling, or gradual change. Effects include 

Gaussian Blur, Motion Blur, and Zoom. 

 

 

 

 

 

 

 

 

Color Transform :-You create photographic illusions by using color reduction and 

replacements. Effects include Halftone, Psychedelic, and Solarize. 

 

 

 

 

 

Contour : You highlight and enhance the edges of an image. Effects include Edge Detect and 

Trace Contour. 
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Lesson no. 18: Corel Draw Menu Bar 

 
 Text  Menu- Drop Down list 

 

 

 
 
 
 
  

 
 
 

   

 

 

 

   
 

 

 

 

 

 

 
Artistic and Paragraph Text : CorelDraw uses two text options – Artistic and Paragraph text. 

There are significant changes made with the release of X3. Formatting options can be accessed 

from the TEXT PROPERTY BAR (shown below) or from the menu TEXT ->CHARACTER 

FORMATTING, or TEXT ->CHARACTER FORMATTING shown in 

You can add two types of text to drawings — artistic text and paragraph text. You can add short 

lines of artistic text and then apply a wide range of effects, such as drop shadows or a contour, to 

the text. Paragraph text, also known as “block text,” can be used for larger bodies of text that have 

greater formatting requirements. You can add both paragraph and artistic text directly in the 

drawing window.  

 

Text  Menu 
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CHARACTER FORMATTING : You can format your text from these Option. 

 

 

 

 

 

 

 

 

 

 

Paragraph Text Paragraph Text is similar to text objects used in desktop publish applications. 

Paragraph text can be used for larger bodies of text that have greater formatting requirements. It is 

most often used when creating columns for names on a plaque, or wrapping text around an object. 

When adding paragraph text, you must first create a text frame. The various options for working 

with paragraph text objects 
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Using Paragraph Text for importing a block of text  In this lesson, I want to create a 

paragraph text frame and import the Gettysburg Address which I have saved on my hard drive as a 

Microsoft Word document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using Paragraph Text to create columns of text  In this lesson, I want to use several 

paragraph text frames to create columns for a series of names. 

 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

• First create the actual text frame by 

selecting the TEXT TOOL, and 

CLICK-DRAG to make the text 

frame. 

 
• Place the Text cursor inside the text frame 

and CLICK. From the FILE | IMPORT 
MENU, or the Import icon on Standard 
Property bar, open the import dialog and 
select the file. I will be using the 
Gettysburg address. If you get an 
Importing/Pasting Text dialog, select 
Discard fonts and Formatting. We will 
format the text in Corel DRAW. Note the 
black arrow at the bottom of the text frame. 
This flow marker indicates there is more 
text in the flow than is visible. 

 
• To view all of the text, select TEXT | 

PARAGRAPH TEXT FRAME | FIT TEXT 

TO FRAME. This option will automatically 

adjust the font size allowing all of the text 

to be viewed in text frame. 

 

• First create a text frame with the Text too. 
This is the area our columns will fit. 

 

• Select TEXT | COLUMNS. From the 
Column Settings dialog, select 4 columns, 
change the gutter to .35, and choose 
Maintain current frame width under Frame 
Settings. The dialog is shown. 
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Creating Paragraph Text Frame within objects  

 

 

 

 

 

 

 

 

 

Here is my example lesson for created a paragraph text frame within an object. 

 
 
 
 
 

  

• Place your cursor inside of the text frame 
and you will see the newly created 
columns. 

 
 

• You can type in the names or  
           import them. 
 

• After using the Fit Text To Frame option, 

here’s how my plaque looked 

• Our first step is to click inside our 
object, the light bulb, with the Text Tool. 
Note the dotted lines inside the light 
bulb denoting the text frame 

 

• After entering text and Fitting Text To 
Frame, we have a unique layout. 

• Another popular use for paragraph text 

frames is to create the frames within 

objects. When you first select the object 

with the text tool, the cursor will change to 

the Text in A Close Path as you move the 

cursor over the object. After the cursor 

changes and you click inside, the page 

frame can be seen inside the object. 
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Text Outline Properties When you first install Corel DRAW, you text outline properties are set 

to a color of None and an outline width of None. The laser operator often changes the outline to 

Hairline to cut out letters. Changing the Text Outline width and color can produce different text 

appearances as shown in Figure 3-9. The text outline properties can be changed on the property 

bar or by changing them in the OUTLINE TOOL properties.  

 

 

 

 

 
Fitting text to a path  You can add artistic text along the path of an open object (for example, 

a line) or a closed object (for example, a square). You can also fit existing text to a path. 

Paragraph text can be fitted to open paths only.  

 

After you fit text to a path, you can adjust the text position relative to that path. For example, you 

can mirror the text horizontally, vertically, or both. Using tick spacing, you can specify an exact 

distance between the text and the path.  

 

Corel DRAW treats text fitted to a path as one object; however, you can separate the text from the 

object if you no longer want it to be part of the path. When you separate text from a curved or 

closed path, the text retains the shape of the object to which it was fitted.  

The Fit Objects to Path extension for Corel DRAW lets you fit any type and number of objects to a 

path of your choice. Smart distribution and rotation settings help you customize the placement of 

objects on the path. 

The text reverts to its original appearance when you straighten it.  
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To fit objects to a path   

1 - In Corel DRAW, using the Pick tool, select the objects you want to fit to a path. 

2 Holding down Shift, click the path. 

If you do not select a path, the last object you selected in step 1 is used as a path. 

3 Click Objects  Fit Objects to Path. 

4 In the Fit Objects to Path docker, choose any settings you want. 

5 Click Apply. 

Fit text to frame Using this option you can attach your text into a frame.(a frame can be any 

circle, rectangle or any other type of figures. 

Align to baseline  (using shape tool we can move the characters of the sentence to the desired 

location that can be right top left. Etc) you can use this option to align the characters moved with 

shape tool to the base line. 

Straighten text Using this option you can make the --------- of the sentences moved by the 

shape tool to their locations.  

Writing tools Using these tools you can check your sentence for spellings or grammatical 

Mistake etc. 

 



 

www.dotnetinstitute.co.in           Call us at - 011-4004 0815 

Corel Draw 
Change case Using this option we can change the caw of our text from one case to another 

case like toggle case, sentence case, upper case, lower eaie etc. 

Convert to artistic text Using this option you can convert your text to artistic text in which 

there is no limited bond Erie. OR Convert to paragraph text Using this option you can convert the 

artistic text to a paragraph text in which the bond Erie is limited specified by you for typing 

Text static’s This option show you the status of your text in your document (i.e. number of 

characters names of font styles etc 

Tables Menu Drop down list  

 

 

 

 

 

 
 

 

Tables Menu  

A table provides a structured layout that lets you present text or images within a drawing. You can 

draw a table, or you can create a table from paragraph text. You can easily change the look of a 

table by modifying the table properties and formatting. In addition, because tables are objects, you 

can manipulate them in various ways. You can also import existing tables from a text file or a 

spreadsheet.  

Adding tables to drawings  

With Corel DRAW, you can add a table to a drawing to create a structured layout for text and 
images. You can draw a table, or you can create a table from existing text.  
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Resizing table cells, rows, and columns  

You can resize table cells, rows, and columns. In addition, if you previously changed the sizes of 

so 
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If table rows are different sizes (left), you can distribute them so that they are the same size (right). 

Formatting tables and cells  

You can change the look of a table by modifying both table and cell borders. For example, you can 
change the table border width or color.  

You can modify both table and table cell borders.  

In addition, you can change the table cell margins and cell border spacing. The cell margins let you 

increase the space between the cell borders and the text in the cell. By default, table cell borders 

overlap to form a grid. However, you can increase the cell border spacing to move the borders 

away from each other. As a result, the cells do not form a grid, but appear as individual boxes (also 

known as “separated borders”).  

 

 

 

 

 

 

 

Merging and splitting tables and cells  

You can change how a table is configured by merging adjacent cells, rows, and columns. If you 
merge table cells, the formatting of the upper-left cell is applied to all merged cells. Alternatively, 
you can unmerge cells that were previously merged.  
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You can change the look of a table (left) by merging adjacent table cells (right).  

You can also split table cells, rows, or columns. Splitting lets you create new cells, rows, or 
columns without changing the size of the table.  

You can insert additional rows in a table (left) by splitting table cells (right).  

Tools Menu Drop down list  

 

 

 

 

 

 

 

 

 

 

 

 

 

Tools  

 

Undo docker - It contain the record of your steps those you used in deginq your document.  

 

Symbols and special characters  -You can select various types of symbols and drag then 

into the document from its locker window. 
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Windows  Menu Drop down list  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Windows  

Color palettes -It contain the list of various color boxes.  

Dockers -It contains the list of the various docker windows that you used in coral draw.  

Refresh window -This option …… your documents. To use this tool you can also peas  

(control + n)   
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Lesson no. 19: Corel Draw Shortcut Keys  

 
Used Corel DRAW Shortcut Keys 

Below are the different shortcuts keys that can be used while using Corel DRAW: 
 

Option Keyboard 
shortcut 

Action 

Align 
 

Align Top T 
It lets you align the objects that are selected to 
the top. 

Align Bottom B It lets you align the objects that are selected to 
the bottom. 

Align Right R It lets you align the objects that are selected to 
the right. 

Align Left L It lets you align the objects that are selected to 
the left. 

Align Center Vertically C You can vertically align the center of the objects 
that are selected. 

Align Center Horizontally E You can horizontally align the center of the 
objects that are selected. 

Align to baseline Alt + F12 It allows you to align text to the baseline. 

Display Document Shortcut Keys in Corel DRAW 
 

Window Refresh Ctrl + W You can refresh the window with this shortcut. 

Reveal Nonprinting 
Characters 

Ctrl + Shift + C Nonprinting characters can be shown 

Display Toggle Shift + F9 Toggle can be displayed. 

Preview Full-Screen F9 Full-Screen can be previewed. 

General Shortcuts Keys in Corel DRAW 

 

Copy Ctrl + C, Ctrl + 
Insert 

You can copy and move one or more objects to 
the clipboard 

Cut Ctrl + X, Ctrl + 
Delete 

You can cut and move one or more objects to 
the clipboard. 

Delete Delete(Button) Selected objects can be deleted using this 
button. 
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Paste Ctrl + V You can place the content in the document. 

Repeat Ctrl + R The last operation can be repeated. 

Redo Ctrl + Shift + Z The last action which was undone can be 
reapplied using redo. 

Duplicate Ctrl + D Selected objects can be duplicated. 

Undo Ctrl + Z, Ctrl + 
Backspace 

The previous action can be canceled using undo 

File Related Shortcut Keys (Formatting) 

 

Save Ctrl + S The document that is active can be saved. 

Save As Ctrl + Shift + S The document that is active can be saved using 
a new name. 

Open Ctrl + O You can open a document that is existing by 
searching the folder in which the document is 
present. 

New Ctrl + N You can create a new document. 

Import Ctrl + I It lets you import a file into the document that is 
active. 

Export Ctrl + E The duplicate of the document can be saved to 
a different file format 

Print Ctrl + P Printing options can be selected and then you 
can print the active document. 

Exit: Alt + F4 It lets you exit CorelDRAW and you will get a 
popup to save the active document. 

Docker Window Shortcut Keys in CorelDRAW 

 

Contour Ctrl + F9 Contour docker window can be opened through 
this shortcut. 

Position Alt + F7 Position docker window can be opened through 
this shortcut. 

Rotate Alt + F8 Rotate docker window can be opened through 
this shortcut. 

Envelope: Ctrl + F7 Envelope docker window can be opened 
through this shortcut 

Lens Alt + F3 Lens docker window can be opened through this 
shortcut. 

Graphic And Text Style Ctrl + F5 Graphic and text style docker window can be 
opened through this shortcut. 
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Linear Dimensions Alt + F2 Linear Dimensions docker window can be 

opened through this shortcut. 

Size Alt + F10 A size docker window can be opened through 
this shortcut. 

Scale And Mirror Alt + F9 Scale and mirror docker window can be opened 
through this shortcut. 

Dialog Shortcut Keys 

 

Intensity/Brightness Ctrl + B You can adjust the brightness with this shortcut. 

Color Balance Ctrl + Shift + B You can adjust the color balance with this 
shortcut. 

Saturation/Hue Ctrl + Shift + U Saturation can be controlled using this shortcut. 

Uniform Fill Shift + F11 Helps you in selecting a hard fill color by using 
color palettes, color harmonies, color viewers or 
color blends for an object. 

Fountain Fill F11 Using a gradient of shades or colors, an object 
can be filled. 

Font Shortcut Keys(Formatting) 

 

Font Size Ctrl + Shift + P You can adjust the font size with this. 

Increase Font Size Ctrl + Numpad 8 Font size can be increased with this. 

Decrease Font Size Ctrl + Numpad 2 Font size can be decreased with this. 

Bold Ctrl + B You can make the text bold. 

Italic Ctrl + I You can italicize the text. 

Outline Pen 

 

Outline Color Dialog Shift + F12 Outline color dialog can be opened with this 
shortcut. 

Toolbox 

 

Hand H You can select the hand tool. 

Artistic Media I With the use of freehand strokes, you can add 
artistic spray, brush and some calligraphic 
effects. 

Ellipse Tool F7 You can select the ellipse tool. 
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Eraser Tool X You can select the eraser tool. 

Freehand Tool F5 The freehand tool can be selected. 

Mesh Tool M Mesh tool can be selected. 

Rectangle Tool F6 A rectangle tool can be selected. 

Polygon Tool Y Polygon tool can be selected. 

Spiral Tool A The spiral tool can be selected. 

Text Tool: F8 The text tool can be selected. 

Zoom 

 

Zoom Out F3 You can zoom out. 

Zoom F2 You can zoom in one shot. 

Zoom in to all object F4 You can zoom in to an object as a whole. 

 

Conclusion:- 

Corel DRAW Shortcut Keys are definitely useful when you need to expedite your work and 
maintain professionalism at the same time.  
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Artistic and Paragraph Text : CorelDraw uses two text options – Artistic and Paragraph text. 

There are significant changes made with the release of X3. Formatting options can be accessed 

from the TEXT PROPERTY BAR (shown below) or from the menu TEXT ->CHARACTER 

FORMATTING, or TEXT ->CHARACTER FORMATTING shown in 

You can add two types of text to drawings — artistic text and paragraph text. You can add short 

lines of artistic text and then apply a wide range of effects, such as drop shadows or a contour, to 

the text. Paragraph text, also known as “block text,” can be used for larger bodies of text that have 

greater formatting requirements. You can add both paragraph and artistic text directly in the 

drawing window.  

 

  

   

 

 

 

 

 

CHARACTER FORMATTING : You can format your text from these Option. 
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Paragraph Text Paragraph Text is similar to text objects used in desktop publish applications. 

Paragraph text can be used for larger bodies of text that have greater formatting requirements. It is 

most often used when creating columns for names on a plaque, or wrapping text around an object. 

When adding paragraph text, you must first create a text frame. The various options for working 

with paragraph text objects 

 

 

 

 

 

 

 

 

 

 

 

Using Paragraph Text for importing a block of text  In this lesson, I want to create a 

paragraph text frame and import the Gettysburg Address which I have saved on my hard drive as a 

Microsoft Word document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• First create the actual text frame by 

selecting the TEXT TOOL, and 

CLICK-DRAG to make the text 

frame. 

 
• Place the Text cursor inside the text frame 

and CLICK. From the FILE | IMPORT 
MENU, or the Import icon on Standard 
Property bar, open the import dialog and 
select the file. I will be using the 
Gettysburg address. If you get an 
Importing/Pasting Text dialog, select 
Discard fonts and Formatting. We will 
format the text in Corel DRAW. Note the 
black arrow at the bottom of the text frame. 
This flow marker indicates there is more 
text in the flow than is visible. 

 
• To view all of the text, select TEXT | 

PARAGRAPH TEXT FRAME | FIT TEXT 

TO FRAME. This option will automatically 

adjust the font size allowing all of the text 

to be viewed in text frame. 
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Using Paragraph Text to create columns of text  In this lesson, I want to use several 

paragraph text frames to create columns for a series of names. 

 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

• First create a text frame with the Text too. 
This is the area our columns will fit. 

 

• Select TEXT | COLUMNS. From the 
Column Settings dialog, select 4 columns, 
change the gutter to .35, and choose 
Maintain current frame width under Frame 
Settings. The dialog is shown. 

 
 

• Place your cursor inside of the text frame 
and you will see the newly created 
columns. 

 
 

• You can type in the names or  
           import them. 
 

• After using the Fit Text To Frame option, 

here’s how my plaque looked 
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Creating Paragraph Text Frame within objects  

 

 

 

 

 

 

 

 

 

Here is my example lesson for created a paragraph text frame within an object. 

 
 
 
 
 

  

• Our first step is to click inside our 
object, the light bulb, with the Text Tool. 
Note the dotted lines inside the light 
bulb denoting the text frame 

 

• After entering text and Fitting Text To 
Frame, we have a unique layout. 

• Another popular use for paragraph text 

frames is to create the frames within 

objects. When you first select the object 

with the text tool, the cursor will change to 

the Text in A Close Path as you move the 

cursor over the object. After the cursor 

changes and you click inside, the page 

frame can be seen inside the object. 
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Text Outline Properties When you first install Corel DRAW, you text outline properties are set 

to a color of None and an outline width of None. The laser operator often changes the outline to 

Hairline to cut out letters. Changing the Text Outline width and color can produce different text 

appearances as shown in Figure 3-9. The text outline properties can be changed on the property 

bar or by changing them in the OUTLINE TOOL properties.  

 

 

 

 

 
Fitting text to a path  You can add artistic text along the path of an open object (for example, 

a line) or a closed object (for example, a square). You can also fit existing text to a path. 

Paragraph text can be fitted to open paths only.  

 

After you fit text to a path, you can adjust the text position relative to that path. For example, you 

can mirror the text horizontally, vertically, or both. Using tick spacing, you can specify an exact 

distance between the text and the path.  

 

Corel DRAW treats text fitted to a path as one object; however, you can separate the text from the 

object if you no longer want it to be part of the path. When you separate text from a curved or 

closed path, the text retains the shape of the object to which it was fitted.  

The Fit Objects to Path extension for Corel DRAW lets you fit any type and number of objects to a 

path of your choice. Smart distribution and rotation settings help you customize the placement of 

objects on the path. 

The text reverts to its original appearance when you straighten it.  

 

 

 

 

 

 

 

javascript:hhctrl.TextPopup(Popup_wp1513789,%20'Arial,8',%2010,%2010,%20-1,%20-1);
javascript:hhctrl.TextPopup(Popup_wp1516555,%20'Arial,8',%2010,%2010,%20-1,%20-1);
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www.dotnetinstitute.co.in           Call us at - 011-4004 0815 

Corel Draw 
 

 

 

 

 

 

 

 

 

 

To fit objects to a path   

1 - In Corel DRAW, using the Pick tool, select the objects you want to fit to a path. 

2 Holding down Shift, click the path. 

If you do not select a path, the last object you selected in step 1 is used as a path. 

3 Click Objects  Fit Objects to Path. 

4 In the Fit Objects to Path docker, choose any settings you want. 

5 Click Apply. 

Fit text to frame Using this option you can attach your text into a frame.(a frame can be any 

circle, rectangle or any other type of figures. 

Align to baseline  (using shape tool we can move the characters of the sentence to the desired 

location that can be right top left. Etc) you can use this option to align the characters moved with 

shape tool to the base line. 

Straighten text Using this option you can make the --------- of the sentences moved by the 

shape tool to their locations.  

Writing tools Using these tools you can check your sentence for spellings or grammatical 

Mistake etc. 
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Change case Using this option we can change the caw of our text from one case to another 

case like toggle case, sentence case, upper case, lower eaie etc. 

Convert to artistic text Using this option you can convert your text to artistic text in which 

there is no limited bond Erie. OR Convert to paragraph text Using this option you can convert the 

artistic text to a paragraph text in which the bond Erie is limited specified by you for typing 

Text static’s This option show you the status of your text in your document (i.e. number of 

characters names of font styles etc 

Tables Menu Drop down list  

 

 

 

 

 

 
 

 

Tables Menu  

A table provides a structured layout that lets you present text or images within a drawing. You can 

draw a table, or you can create a table from paragraph text. You can easily change the look of a 

table by modifying the table properties and formatting. In addition, because tables are objects, you 

can manipulate them in various ways. You can also import existing tables from a text file or a 

spreadsheet.  

Adding tables to drawings  

With Corel DRAW, you can add a table to a drawing to create a structured layout for text and 
images. You can draw a table, or you can create a table from existing text.  
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Resizing table cells, rows, and columns  

You can resize table cells, rows, and columns. In addition, if you previously changed the sizes of 

so 
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If table rows are different sizes (left), you can distribute them so that they are the same size (right). 

Formatting tables and cells  

You can change the look of a table by modifying both table and cell borders. For example, you can 
change the table border width or color.  

You can modify both table and table cell borders.  

In addition, you can change the table cell margins and cell border spacing. The cell margins let you 

increase the space between the cell borders and the text in the cell. By default, table cell borders 

overlap to form a grid. However, you can increase the cell border spacing to move the borders 

away from each other. As a result, the cells do not form a grid, but appear as individual boxes (also 

known as “separated borders”).  

 

 

 

 

 

 

 

Merging and splitting tables and cells  

You can change how a table is configured by merging adjacent cells, rows, and columns. If you 
merge table cells, the formatting of the upper-left cell is applied to all merged cells. Alternatively, 
you can unmerge cells that were previously merged.  
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You can change the look of a table (left) by merging adjacent table cells (right).  

You can also split table cells, rows, or columns. Splitting lets you create new cells, rows, or 
columns without changing the size of the table.  

You can insert additional rows in a table (left) by splitting table cells (right).  

Tools Menu Drop down list  

 

 

 

 

 

 

 

 

 

 

 

 

 

Tools  

 

Undo docker - It contain the record of your steps those you used in deginq your document.  

 

Symbols and special characters  -You can select various types of symbols and drag then 

into the document from its locker window. 
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Windows  Menu Drop down list  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Windows  

Color palettes -It contain the list of various color boxes.  

Dockers -It contains the list of the various docker windows that you used in coral draw.  

Refresh window -This option …… your documents. To use this tool you can also peas  

(control + n)   
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